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Kit Contents

Storage

Cap
Color

Reagents

12
tests

24 tests

48
tests

1

BROW
N

HBV Mix A

253 μl

391 μl

667 μl

2

YELL
OW

HBV Mix B

187 μl

289 μl

493 μl

3

BLUE

HBV Internal Control

1 tube

1 tube

1 tube

4

RED

HBV Quantification Standard 1 (107
IU/ml)

1 tube

1 tube

1 tube

5

RED

HBV Quantification Standard 2 (106
IU/ml)

1 tube

1 tube

1 tube

6

RED

HBV Quantification Standard 3 (105
IU/ml)

1 tube

1 tube

1 tube

7

RED

HBV Quantification Standard 4 (104
IU/ml)

1 tube

1 tube

1 tube

8

WHITE

PCR Grade Water

1 tube

1 tube

1 tube

All reagents of RTA HBV Real-Time PCR Kit should be stored at -20°C. Storage at higher temperatures should
be avoided (e.g. +4°C). Under these conditions, kit contents should be stable through the expiration date printed
on the label. The reagents should not be freeze-thawed more than 2 times; otherwise the shelf of the kit will
reduce. During the working steps all reagents should be kept on ice.
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Intended
Use

RTA HBV Real-Time PCR Kit is an in vitro nucleic acid amplification assay for quantification of Hepatitis B virus
(HBV) DNA in human serum or plasma (EDTA) using RTA VOLTRAN Viral Load Detection System (HAMILTON
Microlab STARlet IVD and BIO-RAD CFX96-IVD Real-Time PCR Detection System). RTA HBV Real-Time PCR Kit is
intended for use as an aid in the management of patients with chronic HBV infection undergoing anti-viral therapy to
assess response to treatment in conjunction with all relevant clinical and laboratory findings. RTA HBV Real-Time
PCR Kit is not intended for screening of blood and blood products for the presence of HBV DNA or confirmation of
the diagnosis of infection with HBV.

Product Use
Limitations

All reagents of the kit is for in vitro diagnostic use only.
RTA HBV Real-Time PCR Kit is not intended for screening of blood and blood products for the presence of HBV DNA
or confirmation of the diagnosis of infection with HBV.
This kit has been validated for use with human serum or human plasma collected in EDTA anticoagulant. Test with
other sample types may result in inaccurate results.
This kit has been validated for use with RTA VOLTRAN Viral Load Detection System (HAMILTON Microlab STARlet
IVD and BIO-RAD CFX96-IVD Real-Time PCR Detection System). Using other instruments may adversely affect the
performance characteristics of the kit.
This kit has been optimized for use with specific PCR plastic consumables listed under Additional Materials
Required section of the Handbook. Using other PCR plastic consumables may adversely affect the performance
characteristics of the kit.
Trustworthy results depends on proper sample collection, transport, storage and processing methods.
It is intended for professional use by properly trained personnel.
RTA HBV Real-Time PCR Kit is intended for use as an aid in the management of patients with chronic HBV infection
undergoing anti-viral therapy to assess response to treatment in conjunction with all relevant clinical and laboratory
findings.
The instructions in user manual should be followed strictly for optimum PCR results.
The expired kits should not be used. Kit components from different lots should not be mixed.
5

Product
Description

RTA HBV real-time PCR assay is a fluorogenic probe-based PCR assay in which, situated between two PCR
primers, there is an internal oligonucleotide probe with a fluorescent label attached at the 5'-end and a
quenching molecule that suppresses the fluorescent reporter at the 3'-end. During DNA replication in the PCR
process, the internal oligonucleotide hybridizes to the template and is digested by the 5'-3' endonuclease
activity of the Thermus aquaticus (Taq) DNA polymerase as the PCR primer is extended. The internal
oligonucleotide is digested only if DNA replication occurs, separating the fluorescent and quencher molecules.
PCR products are detected within minutes by monitoring the increase in fluorescence that occurs exponentially
with successive PCR amplification cycles. The parameter Ct (threshold cycle) is defined as the fractional cycle
number at which the fluorescence passes the fixed threshold. A plot of the log of initial target copy number for a
set of standards versus Ct is a straight line. Quantification of the amount of target in unknown samples is
accomplished by measuring Ct and using the standard curve to determine starting copy number. RTA HBV realtime PCR assay utilizes external standards to gather quantitative results and includes an internal control, which
controls for target isolation and amplification. The target region is situated in S gene region of HBV genome and
is 104-bases long. HBV DNA concentration is noted in International Units/ml (IU/ml). If it is needed to convert to
copies/ml, our conversion factor for RTA HBV Real-Time PCR Kit is 8.16 copies/IU. In other words, 1 IU/ml =
8.16 copies/ml.
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Pathogen
Information

The Hepatitis B virus (HBV) with a 3.2 kbp long and partially double stranded DNA genome is a member of the
Hepadnaviridae family (1). The HBV infection can cause acute or chronic liver disease and in the chronic case,
the liver infection may become life threatening by developing into cirrhosis or hepatocellular carcinoma (HCC)
(2). Its transmission is similar to but much more infectious than HIV. The transmission modes are mother-tochild, parenteral and sexual through percutaneous contact with infected blood or body fluids. Once the virus
enters the body, it targets the hepatocytes of liver via its surface antigen (HBsAg). HBV infection is often
acquired during childhood and is generally asymptomatic. The HBV infection in this stage mostly leads to
development of the chronic infection (3). Approximately 400 million people worldwide are chronically infected
with the hepatitis B virus (HBV), and approximately 1 million die annually of HBV-related disease. The worldwide
prevalence of hepatitis B virus ranges from 0.1% to 20%. This wide range is largely due to differences in age at
the time of infection. Following acute HBV infection, the risk of developing chronic infection varies inversely with
age: 90% for perinatal infection, 25–50% for infection at age 1–5 years and 1–5% for all others (4). As being in
an intermediate endemic region, the prevalence of HBsAg seropositivity is 2 to 10% in Turkey (5).
References
1. Gerlich W, Robinson WS. Hepatitis B virus contains protein attached to the 5′ end of its complete strand. Cell.
1980;21:801–811.
2. McMahon The natural history of chronic hepaatitis B virus infection. Hepatology. 2009;49(suppl):S45–S55.
3. Thiers V, Nakajima E, Kremsdorf D, Mack D, Schellekens H, Driss F, et al. Transmission of hepatitis B from
hepatitis-B-seronegative subjects. Lancet. 1988;2:1273–1276.
4. Custer B et al. Global epidemiology of hepatitis B virus. Journal of Clinical Gastroenterology, 2004, 38(10
Suppl):S158–S168.
5.Toy M, Onder FO, Wormann T, Bozdayi AM, Schalm SW, Borsboom GJ, et al. Age- and region-specific
hepatitis B prevalence in Turkey estimated using generalized linear mixed models: a systematic review. BMC
Infect Dis. 2011;11:337. doi: 10.1186/1471-2334-11-337.
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Warnings and
Precautions

All clinical specimens and all resulting waste materials should be treated as potentially infectious; the samples
should be prepared in Bio-safety Level 2 area .
Before and after work all surfaces should be disinfected with a freshly prepared solution of 10% bleach or
antiviral agents.
Dispose of unused reagents, waste and specimens in accordance with country or local regulations.
Do not pipette by mouth.
Do not eat, drink or smoke in laboratory work areas.
Wear protective disposable gloves, laboratory coats and eye-wear when handling clinical specimens and kit
reagents. Wash hands thoroughly after handling specimens and test reagents.
Avoid contact of reagents with the skin, eyes or mucous membranes. If contact does occur, immediately wash
with large amounts of water,
Use all pipetting devices and instruments with care and follow the manufacturer’s
instructions for calibration and quality control; to prevent sample contamination, use new, sterile aerosol barrier
or positive displacement RNase-free pipette tips and sterile pipettes
Handle all materials containing specimens or controls according to Good Laboratory Practices in order to
prevent cross-contamination of specimens or controls.
Store the kit away from any source of contaminating DNA, especially amplified nucleic acid.
Do not mix reagents with different lot numbers or substitute reagents from other manufacturers.
A single type of HBV DNA assay should be used for monitoring a patient. If RTA HBV Real-Time PCR Kit
substitutes another HBV DNA assay, both tests should be used in parallel for at least two subsequent samples.
Do not use a kit after its expiration date.
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Additional
Materials
Required

●

RTA VOLTRAN Viral Load Detection System components:
HAMILTON Microlab STARlet IVD (Cat. No:185011)

●

BIO-RAD CFX96-IVD Real-Time PCR Detection System (Cat. No:1855095-IVD)

●

RTA MB Viral Nucleic Acid Isolation Kit (Cat. No: 090150XX)

●

HAMILTON High Vol. (1mL) CO-RE Tips, Filtered 1000ul tips with filters (Cat. No:235905)

●

HAMILTON Std. Vol. (300uL) CO-RE Tips, Filtered 300ul tips with filters (Cat. No:235903)

●

HAMILTON DEEP WELL PLATE PP 2.2ML BC (Cat. No:235656)

●

HAMILTON Reagent Containers, 60ML (Cat. No:194051)

●

HAMILTON Reagent Containers, 2000ML (Cat. No:56695-01)

●

BIO-RAD Hard-Shell Thin-Wall 96-Well Skirted PCR Plates with Bar Codes (Cat. No:HSP-9955)

●

BIO-RAD Microseal 'B' Adhesive Seals, optically clear (Cat. No:MSB-1001)

●

●

Disposable powder-free gloves

●

Micropipettes (0.5 µl – 1000 µl)

●

Sterile micropipette tips with filters

●

Vortex mixer

●

Desktop microcentrifuge for 2.0 ml tubes and for PCR plates
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Sample
Preparation

This kit has been validated for use with human serum or human plasma collected in EDTA anticoagulant.
Aseptic techniques must be employed during collection to prevent the introduction of micro-organisms into the
patient’s anatomical space, and to prevent the sample from being contaminated during the process of collection.
All samples should be regarded as potentially infectious and standard precautions guidelines should be followed
by all healthcare workers during sample collection and handling.
Samples must be collected into appropriate containers before despatch to the laboratory. Formats accepted are
4ml and 7ml Vacutainers (BD #368861 and #367864) or similar tubes that do have the same inner dimensions
as these two tubes (round-bottom and inner diameter).
Be careful to check for cracks in the containers and to ensure that the lids of containers are properly tightened
to prevent leakage of samples during handling and transportation. This can pose infection hazards to transport
and laboratory staff.
Ensure that the outer surfaces of the containers are not contaminated by the patients’ samples.
Store whole blood at room temperature for no longer than 4 hours. Centrifuge blood within 4 hours of collection.
Transportation of whole blood, serum or plasma must conform to country or local regulations for the transport of
etiologic agents.
Serum or plasma samples may be stored at 2-8°C for up to 3 days or frozen at -70°C or
colder for long-term storage.
Avoid multiple freeze/thaw cycles of specimens.
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Protocol

Viral DNA Isolation
RTA VOLTRAN Viral Load Detection System should be used together with RTA MB Viral Nucleic Acid Isolation
Kit (Cat. No: 090150XX) for viral DNA extraction from clinical samples. Starting sample volumes were 200 μl and
elution volumes were 50 μl. Please follow the manufacturer’s instructions as stated in RTA VOLTRAN Viral Load
Detection System Handbook.
Internal Control
During DNA isolation, addition of the supplied internal control (IC) is necessary. IC allows the user to monitor
DNA extraction step as well as to determine any PCR inhibition. There was no amplification of internal control in
the tests where high positive HBV samples were amplified because there was a competition between internal
control template and HBV DNA template for using PCR primers and other components. The Ct value of internal
control of a negative sample should be equal to 33 ± 5, otherwise,it denotes a problem during purification.
Quantification Standards
For generating a standard curve to obtain accurate quantification data on the Real-Time system, four
quantification standards should be used. For each standard the corresponding concentration should be defined
properly to the Real-Time PCR system before each run and the standard curve will be generated accordingly at
the end of the reaction.
Since starting sample volumes were 200 μl and elution volumes were 50 μl, the concentration factor is 4. If we
define the corresponding concentration for each standard by dividing the original concentration by 4, the
concentration of each positive sample will be automatically calculated by CFX Manager software. The
concentrations of the standards are already defined either in plate file (.pltd extension) under Templates folder
for manual programming or in LIMS file generated by HAMILTON Microlab STARlet IVD.
PCR Setup
RTA VOLTRAN Viral Load Detection System should be used together with RTA HBV Real-Time PCR Kit, version
2.0 (Cat. No: 090110XX) for setting up PCR reactions. Four quantification standards and one negative control
should be included for every run. Please follow the manufacturer’s instructions as stated in RTA VOLTRAN Viral
Load Detection System Handbook.
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Protocol
(continued)

Running Assay on BIO-RAD CFX96-IVD Real-Time PCR Detection System by Manual Programming
Close the PCR plate with BIO-RAD Microseal 'B' Adhesive Seal, and place it in the 96-well block. Close the lid.
The Startup Wizard automatically appears when Bio-Rad CFX Manager software is first opened. If it is not
shown, click the Startup Wizard button on the main software window toolbar. Click User-defined option in the
Startup Wizard (Figure 1).
Figure 1. Startup Wizard window.
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Protocol
(continued)

Click the Protocol tab and then click the Select Existing tab to select RTA HBV Real-Time PCR Kit protocol file
(.prcl extension) under Templates folder to run (Figure 2).
Figure 2. Protocol selection window.
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Protocol
(continued)

Then click the Plate tab and then click the Select Existing tab to select RTA HBV Real-Time PCR Kit plate file
(.pltd extension) under Templates folder to load. Then edit the plate according to the test number and sample
information by clicking Edit Selected option (Figure 3).
Figure 3. Plate selection window.
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Protocol
(continued)

Click the Start Run tab and then click the Start Run button to begin the experiment.(Figure 4).
Figure 4. Start Run window.
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Protocol
(continued)

Running Assay on BIO-RAD CFX96-IVD Real-Time PCR Detection System by LIMS Integration
CFX Manager software can be configured for use with a Laboratory Information Management System (LIMS).
For LIMS integration, CFX Manager software requires plate setup information generated by HAMILTON Microlab
STARlet IVD (a LIMS file, *.plrn), a protocol file created using CFX Manager software (*.prcl), a defined data
export location, and a defined export format.
Setting up LIMS Folder and Data Export Options
1. Select Tools > Options from the main software menu bar then select the LIMS tab (Figure 5) to define the
folder location that will contain the LIMS protocol (*.prcl), LIMS file (*.plrn), and exported data.
Figure 5. Options window displaying the LIMS settings tab.
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Protocol

2. At run completion, a LIMS data export file can be automatically generated in addition to the CFX Manager

(continued)

software *.pcrd data file. Check the Automatically Export Data after Run (Figure 5) box to have the data
exported automatically once a run is completed.
3. Click the Data Export Settings button to specify the file format to be used for the exported data and which
information fields will be exported (Figure 6).
Figure 6. LIMS Data Export Format Settings window.
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Protocol
(continued)

Creating a LIMS Protocol
To start a LIMS run, a CFX Manager software protocol file (*.prcl) must be created and saved in the designated
LIMS protocol folder location specified in the LIMS tab of the Options window.
Creating a LIMS File
A LIMS file (*.plrn) contains the plate setup details and the protocol file name. This file is generated by
HAMILTON Microlab STARlet IVD (a LIMS file, *.plrn). CFX Manager software will use the LIMS file to create a
plate file that will be used in conjunction with the named protocol file to start a run and generate data.
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Protocol
(continued)

Initiating a LIMS Run
Close the PCR plate with BIO-RAD Microseal 'B' Adhesive Seal, and place it in the 96-well block. Close the lid.
To initiate a LIMS run:
1. Open a LIMS file using one of the following methods:
• Drag and drop the .plrn file onto the CFX Manager software window or desktop icon
• Select Tools > LIMS File Folder from the main software window menu bar. Double-click on the desired .plrn
file to open the run
• Select File > Open > LIMS file from the main software window menu bar. Select the .plrn file from the LIMS
folder and click Open
2. To start the run for a selected LIMS file, select an instrument and click Start Run (Figure 7). The contents of
the LIMS file and linked protocol file are used to complete the protocol and plate tabs.
Figure 7. Run Setup window with a LIMS run ready to start.
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Protocol

Exporting Data to a LIMS

(continued)
Upon run completion, a CFX Manager software data (.pcrd) file is generated and saved to the defined data
export folder location (Figure 5).
When Automatically Export Data after Run is selected in LIMS Options, a second data file compatible with
LIMS data retrieval will be saved to the same location. The file format and contents are defined using LIMS Data
Export Format settings. To export this data manually, select Export > Export to LIMS Folder from the main
software window menu bar.
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Data Analysis
2

To be able to evaluate the experiment, PCR efficiency of the Standard Curve must be between 90%-110% and R value must be more than
0.98. Otherwise, the experiment should be repeated.The baseline threshold values are 500 for FAM and 500 for HEX. (In the laboratories
that RTA VOLTRAN Viral Load Detection System is installed, FAM and HEX values are pre-adjusted on CFX Manager, user do not adjust
manually). Then, the concentration of each sample will be calculated by the CFX Manager software according to the standard curve as
International Unit per milliliter (IU/ml). If it is needed to convert the quantitative results from IU/ml to copies/ml, the conversion factor for RTA
HBV Real-Time PCR Kit, version 2.0 is 8.16 copies/IU. In other words, 1 IU/ml = 8.16 copies/ml.The interpretation on the results given by the
software can be done as follows:
Signal
detected
İn FAM
channel

Signal
detected
İn HEX
channel

Quantitative
result
from the
software

Conclusion

+

+

<10 IU/ml

The result is valid.
HBV DNA is detected at a concentration <10 IU/ml.
Quantitation is not possible since the quantitative result
is below the analytical sensitivity value of the assay.
Reproducibility of the positive result is not guaranteed.

+

+/-

≥10 IU/ml

The result is valid.
HBV DNA is detected at the concentration calculated by
the software since the quantitative result is within the
linear range of the assay.

and
≤1 x 109 IU/ml
+

+/-

>1 x 109 IU/ml

-

+

N/A

-

-

N/A

The result is valid.
HBV DNA is detected at a concentration >1 x 10 9 IU/ml .
Quantitation is not possible since the quantitative result
is above the linear range of the assay.
The result is valid.
Target (HBV DNA) is not detected.
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The result is invalid.
No diagnostic interpretation can be done.

Performance
Characteristics

Analytical Sensitivity
Analytical sensitivity was analyzed by use of a dilution series of WHO standard, and the cutoff value of the kit
was determined by probit analysis for BIO-RAD CFX96-IVD Real-Time PCR Detection System. A dilution series
of a 3rd WHO International HBV standard (NIBSC code: 10/264) was prepared to give the final concentrations of
100, 50, 20, 10, 5 and 1 IU/ml. Dilutions were extracted by RTA VOLTRAN Viral Load Detection System
according to the instructions written in the handbook. Starting sample volumes were 200 µl and elution volumes
were 50 µl. Each dilution was tested in 24 replicates. Lower limit was calculated by probit analysis done by
PASW Statistics 18 program. RTA HBV Real-Time PCR Kit, version 2.0 can detect HBV DNA at concentration of
10 IU/ml with a probability rate of 95 %. And, 95 % confidence range is 7.9 – 14.9 IU/ml.
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Performance
Characteristics

Linear Range
To determine the upper limit, a dilution series of Acrometrix HBV Panel (Cat. No: 950150) ranging from 1 x 10 3
IU/ml to 1 x 107 IU/ml were prepared.Viral DNA was extracted from standards by RTA VOLTRAN Viral Load
Detection System according to the instructions written in the handbook. Starting sample volumes were 200 µl
and elution volumes were 50 µl. High concentration samples (1 x 10 8 and 1 x 109 IU/ml) were prepared by using
calibrated plasmid DNA bearing HBV external standard.Within this range, the relationship between log of target
DNA and Ct values is linear. Linear regression analyses comparing the Ct values-versus- log of target DNA
were as follows:
2

Ct value = -3.280(log of target DNA) + 42.44; with a correlation coefficient (R ) of 0.999.
Upper limit is at least 1 x 109 IU/ml for BIO-RAD CFX96-IVD Real-Time PCR Detection System.
Lower limit was calculated by probit analysis done by PASW Statistics 18 program according to the
quantification results of HBV Analytical Sensitivity Studies. 95 % lower confidence limit is 9.9 IU/ml for BIO-RAD
CFX96-IVD Real-Time PCR Detection System.
9

RTA HBV Real-Time PCR Kit, version 2.0 has a linear range between 9.9 IU/ml and 1 x 10 IU/ml.
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Performance
Characteristics

Precision
4

rd

For each experiment, 24 replicates of 10 IU/ml 3 WHO International Standard for HBV DNA assays were
used. Viral DNA was extracted from WHO standards by RTA VOLTRAN Viral Load Detection System according
to the instructions written in the handbook. The results on basis of Ct values are shown in the first table. In the
second table, the descriptives of the log voncentration results for RTA VOLTRAN Viral Load Detection System is
seen.:
Descriptive Statistics
N

Mean

Std.
Deviation

Variance

Coefficient of
variation (%)

Intra_assay

24

32,5329

,43500

,189

1,33

Inter_assay

24

32,6117

,28756

,083

0,88

Inter_batch

24

31,7504

,42992

,185

1,35

STRATAGENE_3005

24

32,5175

,63597

,404

1,96

INCEPTRA_Cycler_9660

24

32,4942

,35985

,129

1,10

BIO-RAD CFX96

24

31,2446

,18111

,033

0,58

TOTAL

144

32,1919

,65587

,430

2,04

Descriptive Statistics
N

Mean

Std.
Deviation

Variance

Coefficient of
variation (%)

Intra_assay

24

4.005

,067

,005

1,68

TOTAL

24

4.005

,067

,005

1,68
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Performance
Characteristics

Genotype Detectability
The performance of RTA HBV Real-Time PCR Kit was evaluated with Teragenix HBV Genotype Performance
Panel and 1st WHO International Reference Panel for HBV Genotypes for nucleic acid amplification technique
(NAT)-based assays. The Panels contain HBV genotypes A, B, C, D, E, F, G and H. As a result of this study, RTA
HBV Real-Time PCR Kit can detect and quantify all of eight HBV genotypes.
Diagnostic Specificity
HBV negative clinical specimens were analyzed to determine the diagnostic specificity of RTA HBV Real-Time
PCR Kit, version 2.0. 50 Hepatitis B virus DNA negative clinical serum specimens and 60 Hepatitis B virus DNA
negative clinical EDTA plasma specimens were used. Viral DNA was extracted from HBV negative clinical
specimens

by RTA VOLTRAN Viral Load Detection System according to the instructions written in the

handbook.
None of the

HBV negative clinical specimens gave positive test result for Hepatitis B DNA. Diagnostic

specificity of RTA HBV Real-Time PCR Kit, version 2.0 is 100 %. All of the Internal Controls of tests gave
positive result.
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Performance
Characteristics

Cross Reactivity
To examine the specificity of an assay, cross-reactivity studies should be performed for potential cross-reactive
markers. In this study, the specificity of the assay was evaluated by testing 7 reference organism and 8 clinical
specimens which were positive. RTA HBV Real-Time PCR Kit do not show any cross-reactivity with other
potential cross-reactive markers given in the table below:
Organism

Source

Test Result

Cytomegalovirus (CMV)

Acrometrix (Cat. No: 94-2014)

Negative

Human Herpes Simplex virus type 1 (HSV-1)

NIBSC (Cat. No: 08/224)

Negative

Human Herpes Simplex virus type 2 (HSV-2)

NIBSC (Cat. No: 08/226)

Negative

Epstein-Barr Virus (EBV)

NIBSC (Cat. No: 08/316)

Negative

Hepatitis C virus (HCV)

NIBSC (Cat. No: 06/100)

Negative

Human Immunodeficiency Virus 1 (HIV-1)

NIBSC (Cat. No: 97/650)

Negative

Mycobacterium tuberculosis

ATCC (25177)

Negative

Cytomegalovirus (CMV) (2 samples)

Clinical specimens

Negative

HPV 16 and HPV 6

Clinical specimens

Negative

Parvovirus B19

Clinical specimens

Negative

Epstein-Barr Virus (EBV)

Clinical specimens

Negative

Hepatitis C virus (HCV)

Clinical specimens

Negative

Clinical specimens

Negative

Human Immunodeficiency Virus 1 (HIV-1)
26

Performance
Characteristics

Cross-Contamination
In this study, cross-contamination between samples was evaluated. To do this, five different runs were
performed. In every run, 4 high positive HBV sample and 4 HBV negative samples were used. Then, the kit was
evaluated accordingly whether or not any cross-contamination was observed.
No cross-contamination was observed during the whole process, and none of the human serum samples
exhibited evidence of containing PCR inhibitors as indicated by the amplification of internal control.
Whole System Failure
60 Hepatitis B virus DNA negative clinical serum specimens and 60 Hepatitis B virus DNA negative clinical
EDTA plasma specimens were spiked with WHO International HBV standard (NIBSC code: 10/264) to give a
final concentrations of 30 IU/ml in the elution volume which is 3 times the 95% positive cutoff value determined
by analytical sensitivity study. Spikes were extracted by RTA VOLTRAN Viral Load Detection System according
to the instructions written in the handbook. Whole system failure rate of RTA HBV Real-Time PCR Kit is ≤1 %.
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